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INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with Icom’ s state of the art technology 

and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This instruction manual contains detailed instructions on how to configure your own remote control system.
Before reading this manual, please read the RS-R8600 Preparations that comes with the RS-R8600, for details on 

how to install the software.

Icom, Icom Inc. and the Icom logo are registered trademarks of Icom Incorporated (Japan) in Japan, the United States, the United Kingdom, 

Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.

Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 

countries.

Microsoft and Windows are trademarks of the Microsoft group of companies.

All other products or brands are registered trademarks or trademarks of their respective holders.

IMPORTANT

READ THIS INSTRUCTION MANUAL CAREFULLY 

before attempting to configure the software.

SAVE THIS INSTRUCTION MANUAL. This 

instruction manual contains important safety and 

operating instructions for the RS-R8600.

NOTE:

This instruction manual is based on Icom Remote 

Utility Version 2.21 and RS-R8600 Version 1.01.

 • In this manual, Microsoft® Windows® 10 Home 

and Microsoft® Windows® 10 Pro are described as 

“Windows 10.”

 • Microsoft® Windows® 8.1 and Microsoft® Windows® 

8.1 Pro are described as “Windows 8.1.” 

The software cannot be used with “RT” versions of 

Microsoft® Windows® 8.1.

PRECAUTIONS

The RS-R8600 is designed to remotely control the  

IC-R8600 receiver* using the LAN port.

*  The IC-R8600 firmware needs to be updated to 1.20 
or later.

Depending on the PC performance, OS, IP provider, 

connection type, condition and speed, and so on, the 

USB audio may be interrupted, or control by the PC 

software may get delayed.

If the CPU has a heavy load, the USB audio is 

easily interrupted. The settings of the audio player 

application may be changed after connecting a 

receiver to the PC.

To operate your PC and peripheral devices, follow the 

instructions provided in their manuals.

All copyrights associated with this manual and all 

intellectual property rights associated with the  

RS-R8600 software are held by Icom Inc. 

Unauthorized reproduction or transmission of this 

manual, or any part hereof, is prohibited.

The content of this manual and the software 

associated with the RS-R8600, and the appearance of 

the RS-R8600 are all subject to change without notice.
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Functions and features of Adobe® Acrobat® Reader®

The following functions and features can be used with Adobe® Acrobat® Reader®.

• Keyword search

    Click “Find” (Ctrl+F) 

or “Advanced Search” 

(Shift+Ctrl+F) in the Edit menu to 

open the search screen.

    This is convenient when 

searching for a particular word or 

phrase in this manual.
   L The menu screen may differ, 

depending on the Adobe® 

Acrobat® Reader® version.

• Find screen

• Advanced search screen

Click to open the find or search 
screen or advanced search screen.

• Printing out the desired pages.

    Click “Print” in the File menu, and then select the 

paper size and page numbers you want to print.

 L The printing setup may differ, depending on the 

printer. Refer to your printer’s instruction manual 

for details.

 L Select “A4” size to print out the page in the 

original manual size.

• Read Out Loud feature.

    The Read Out Loud feature reads aloud the text in 

this PDF.

    Refer to the Adobe® Acrobat® Reader® Help for the 

details.

   ( This feature may not be usable, depending on your 

PC environment including the operating system.)

L The screen may differ, depending on the Adobe® Acrobat® 

Reader® version.
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OVERVIEW OF THE RS-R8600

 • The RS-R8600 consists of the Remote Utility, used to configure a remote control system, and the Remote 
Controller, used to send CI-V commands to a receiver to remotely operate it.

 • With the RS-R8600, you can configure a remote control system through a LAN or the Internet.

About the remote control system

An RS-R8600 remote control system basically consists of following three components:

 • Receiver

 • Network (LAN or Internet)

 • PC

The PC controls the receiver through the network (LAN or Internet).

 LTo control the receiver, the receiver must be connected to the network.

TIP: The IC-R8600’s built-in Server function enables the receiver to directly connect to a network. This enables 

remote control without needing a separate PC computer for the receiver.

Receiver Network PC

LANLAN Or

Routers or other devices are not shown.

InternetInternet
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BEFORE USING THE REMOTE CONTROL SYSTEM1

Firewall settings

The Windows operating system includes a firewall setting standard. This is a security function that can prevent 
improper access to your PC from the Internet.
To let Remote Utility work properly, add it as an exception in the firewall.

Windows 10

1. Right-click the Windows icon on the taskbar, then 

click “Control Panel.” 

1Right-click

2Click

2. Click “System and Security.” 

Click

3. Click “Allow an app through Windows Firewall.” 

Click

 • The “Allowed applications” screen is displayed.
4. Click <Change settings>. 

Click

5. Click <Allow another app...>. 

Click

 • The “Add an app” screen is displayed.
6. Click “Remote Utility Software for Icom Radios” 

and then click <Add>. 

1Click

2Click

 • Returns to the “Allowed applications” screen.
7. In the “Allowed apps and features” list, confirm 

that “Remote Utility Software for Icom Radios” is 
displayed and a check mark is in the box, and 

then click <OK>. 

1Confirm

2Click
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings (Continued)

Windows 8.1

1. Place the mouse pointer in the bottom right corner 

of the screen.
 • The charms are displayed on the right of the screen.

Charms are displayed

Place the mouse pointer 
around here.

2. Click the “Settings” charm. 

Click

3. Click “Control Panel.” 

Click

 • The “Adjust your computer’s settings” screen is 
displayed.

4. Click “System and Security.” 

Click

5. Click “Allow an app through Windows Firewall.” 

Click

 • The “Allowed applications” screen is displayed.
6. Click <Change settings>. 

Click

7. Click <Allow another app...>. 

Click

 • The “Add an app” screen is displayed.
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

Windows 8.1 (Continued)

8. Click “Remote Utility Software for Icom Radios” 
and then click <Add>. 

1Click

2Click

 • Returns to the “Allowed applications” screen.
9. In the “Allowed apps and features” list, confirm 

that “Remote Utility Software for Icom Radios” is 
displayed and a check mark is in the box, and 

then click <OK>. 

1Confirm

2Click
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the volume of your audio devices
Before you start using the RS-R8600, the PC’s audio volume must be set to a proper level.
When several audio devices are used, you must individually set each one.
 • Configurable items, displayed screens and terms that are used may differ, depending on your PC.
 • These instructions are based on using Windows 10.

1.  Right-click the speaker icon on the taskbar, then 

click “Open Sound settings.”
 L  For the Windows 8.1, right-click the speaker icon on 
the taskbar, then click “Sounds.”

1Right-click

2Click

 • The “Sound” screen is displayed.
2. Click “Sound Control Panel.”
3. Select the audio device that you will use, then 

click <Properties>. 

2Select

1Click

3Click

 • The “Speaker Properties” screen is displayed.

4. Confirm “Use this device (enable)” is displayed in 
the Device Usage menu on the <General> tab. 

1Click

2Confirm

5. Click the <Levels> tab. 
Adjust the speaker’s audio level by moving the 
slide control to the right or left.
 • If the mute setting is turned ON in “Speakers” ( ), 

click the icon to turn it OFF.
After adjusting, click <OK> to close “Speaker 
Properties.” 

1Click

2Adjust

3Click
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Receiver’s presettings
The RS-R8600 remotely controls the receivers with the Network function using CI-V (Icom Communication 
Interface) commands.
See the CI-V command table in the receiver’s instruction manual for details of the functions that can be controlled.

The following manual settings are required when operating the RS-R8600
Properly preset the items in the table below for functions that cannot be controlled by CI-V commands, or for items 
that may cause unintended actions. See the receiver’s instruction manual for details of the settings or operation.

Genre Items Contents

Function Timer/Sleep Timer function Set the timer to OFF or to your schedule

Volume Volume for the RX audio Set the volume to a suitable level
CI-V CI-V Baud Rate Desired Baud Rate

Example: Auto (Default)
CI-V Address Desired CI-V Address

Example: 96h (Default)
 L If other devices are connected to the system, 
make sure you do not to set a duplicate 

address.

The following settings are automatically set in the receiver
When the RS-R8600’s Remote Controller connects to the receiver, and you select the model name on the Connect 
Setting screen, the following items are automatically set. If you manually operate the receiver, set these items.

Genre Items Contents

Function Scan function Automatically cancels the scan.
Scan Speech function Automatically set to OFF

SSB/CW Synchronous Tuning Automatically set to OFF

Display Memory channel Automatically set to the VFO mode.
CI-V CI-V transceive Automatically set to ON.
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Selecting a connection method
Select a connection method from the following:

When you want to configure the system through a LAN, see section 2.

When you want to configure the system through the Internet, see section 3.

RS-R8600

Remote PC

Internet

Receiver
with built-in Server function

Remote PC

Receiver
with built-in Server function

RS-R8600
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CONFIGURING THE SYSTEM THROUGH A LAN2

Examples of the remote control system

This section explains the minimum required settings to configure a remote control system through a LAN, 
using the following illustration as an example.

 • Only users whose ID and password are registered to the receiver can connect to it. BE CAREFUL in managing 

IDs and passwords.

 • You can also refer to each application’s help file for assistance with the functions and settings. While the 
application is open, push the [F1] key on the PC’s keyboard to open the help file.

The user ID, password, and other settings in this 

illustration are only examples. Configure the system 
using your own settings.

For your convenience:

If you use an RC-28 remote encoder at the PC, 

you can use the RS-R8600 and feel like you are 

operating the actual receiver’s main dial.

IP address: 192.168.0.10
IP address: 192.168.0.1

RC-28 

(Optional)

PC Name:

User ID:

Password:

User PC

USER1

USER0001

IC-R8600abc

96h

Auto

Network Radio Name:

CI-V address:

Baud rate:

Connect to 

the LAN port

Receiver

InternetInternet

Router
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2 CONFIGURING THE SYSTEM THROUGH A LAN

Step 1. Settings on the receiver

This section describes how to setup the receiver.

To prevent unauthorized access:

Set a long and strong password so that no one can 

possibly guess it.

Mix upper and lower case letters, numbers or 

characters.

NOTE:

When you change a setting that shows “(Valid after Restart),” you must restart the receiver after setting, so it will 
take effect.

After restarting, keep the receiver’s power ON, or remain in the remote standby mode.

*  If you are using the IP address instead of the 

network name, set DHCP to OFF, and set the items 

shown below.

Network setting

Items Contents

DHCP* ON (Default)
Network Name* A Network Name

Example: IC-R8600

Network Control OFF (Default)  ON

Control Port (UDP) 50001 (Default)
Serial Port (UDP) 50002 (Default)
Audio Port (UDP) 50003 (Default)
Internet Access Line Your Internet access line type

Example: FTTH (Default)

Receiver registration

Items Contents

Network Radio Name A Network Radio Name

 • Up to 16 characters

Example: IC-R8600abc

User registration

Items Contents

Network User1/2

ID

A User ID

 • Up to 16 characters

Example: USER1

Network User1/2

Password

A Password

 • 8 to 16 characters

 • At least two different 

characters must be used.

Example: USER0001

Network User1/2

Administrator

NO (Default)  YES

 • When the user is set as an 
administrator.

Items Contents

DHCP ON (Default)  OFF

IP Address An IP address that is not 

assigned to any other device.

Example:  192.168.0.10 

(Default)
Default Gateway An IP address of the LAN 

side on the router

Example: 192.168.0.1

Before setting a PC:

Confirm the receiver settings described below, and keep the receiver’s power ON, or remain in the remote 
standby mode.

 • Network Name or IP Address

 • Network User ID and Password



2-3

2 CONFIGURING THE SYSTEM THROUGH A LAN

Step 2. Settings on the PC’s Remote Utility application

This section describes how to setup the PC.

 LBefore configuring the settings, connect a speaker to the PC.

1 Open the Remote Utility.

1. Open “Icom Remote Utility.”
2. “Set your own PC information” is displayed, 

then click <OK>.
 L When you first open the Remote Utility, this 
screen is displayed.

2
Configure the settings.

 L When you first open the Remote Utility, this screen 
is displayed.

1. Enter a name for your PC of up to 16 

characters. (Example: User PC)
 L DO NOT use the same name for more than one 

PC on your network.

2. Confirm the port numbers of the Control, 
Serial and Audio ports.

 L You should use the default port numbers for 

these ports.

3. Select the network connection type.

4. Select your internet access line type.

5. Select the software display language.
 L The selected language will be used as the Help 

file language.
6. Click <Register> to save the settings.

7. Click <OK>, and then restart the Remote 

Utility.

3

7Click

Click the Setup that you want to do.
 L If no Servers and no radios are registered, this 

screen is displayed.

Click Setup for a Remote PC (A radio with the 

Server function).

Click

4
Start the Setup Wizard.

Click <Next>>.

Click

Click

1 Enter

2 Confirm
3 Select

4 Select

6 Click

5 Select
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2 CONFIGURING THE SYSTEM THROUGH A LAN

Step 2. Settings on the PC’s Remote Utility application (Continued)

5
Enter the Server Information.

1. Enter the receiver Network Name or IP 

Address.

2. Confirm the Control Port number.
 L You should use the default port number for this 

port.

3. Click <Next>>.

1Enter

3Click

6

1Enter

3Click

2Enter

NOTE:

If you cannot connect to the Server, an error dialog 

is displayed.

Click <<Back>, and confirm the settings.

(Example: USER0001)

Enter the User ID and Password.

1. Enter the User ID and Password that are 

registered to the receiver.

2. Click <Next>>.
 • After clicking <Next>>, connects to the Server.

7
Adding the Server has been completed.

1. Enter the Server Description.
 L The Server Address or Network Name is 

entered by default.

2. Click <Finish>. 1Enter

2Click

2Confirm
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2 CONFIGURING THE SYSTEM THROUGH A LAN

Step 2. Settings on the PC’s Remote Utility application (Continued)

8
Configure the settings to connect to the 
receiver.

1. Select the receiver.

2. Click <Settings>.

3. Click <Recommended>.
 • The Select Network screen appears.

4. Select LAN.

5. Click <Next>.
 • The recommended values for your network are 

displayed. 

6. Click <Yes> to automatically set the 

displayed values in each field of the Network 
Setting, then close the Select Network 

screen.

7. Select a virtual COM port number.
 • The selected COM port number is used for CI-V 
operation with the receiver.

 L When you connect to the receiver with the 
control software, you have to set the COM port 

number.

8. Select an audio device that your speaker is 

connected, to output the received audio from 

the network.

9. Click <OK>.

1Click

2Click

3Click

4Select

6Click

5Click

7Select

8Select

9Click
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2 CONFIGURING THE SYSTEM THROUGH A LAN

Step 2. Settings on the PC’s Remote Utility application (Continued)

9
Connect the receiver.

1. Click <Connect>.

2. Click <OK>.
 • “<<Connected>>” is displayed under the radio 
name when the connection has succeeded.

 L If the connection fails, and an error screen 

is displayed, solve the problem using the “6. 
TROUBLESHOOTING” section. (p. 6-2)

1Click

2Click
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2 CONFIGURING THE SYSTEM THROUGH A LAN

Step 3. Remote control operation

This section describes how to connect and remotely control a receiver from a Remote PC using the Remote 

Controller.

 • The description in this section is based on the assumption that the connection to the receiver using the Remote 

Utility has succeeded. (“<<Connected>>” is displayed under the radio name.)

1 Connect setting using the Remote Controller application

1. Open “RS-R8600 Remote Control.”
2. Click <  > in the toolbar, or click “Connect Setting...” in the Option menu.

 • The Connect Setting screen is displayed.

3. Select a receiver to access using the Remote Utility application, in Remote Utility. 

(Example: IC-R8600abc)
 • The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the 

virtual COM Port number, receiver’s CI-V address and baud rate.
 L If the desired receiver is not displayed in Remote Utility, click <Search> to load the receiver’s information from the 

Remote Utility application.

4. Check “Software closing turns OFF the Receiver.” to turn OFF the receiver when the Remote 

Controller application is closed by clicking <  > or “Exit” on the File menu.
 • When the PC shuts down while the Remote Controller application is still running, the receiver’s power may not turn 
OFF.

5. Click <OK> to save the settings and close the screen.

3Select

5Click
4Click
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2 CONFIGURING THE SYSTEM THROUGH A LAN

Step 3. Remote control operation (Continued)

2 Connecting to the receiver using the Remote Controller application

Click <  > in the toolbar, or click “Connect ON” in the File menu.
 • When the connection has succeeded, the receiver’s current data will be displayed on the main panel.

3 Remote control operation

See the RS-R8600 Remote Controller’s Help file for remote operation details, such as how to change the 
frequency, or turn ON each function.

To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the 
[F1] key on your PC’s keyboard.

NOTE: DO NOT allow the PC to go into the sleep or standby mode while using the RS-R8600. Otherwise, it might 

not work properly after the PC resumes normal activity.

When not using the receiver:

Follow the steps below to close and exit the remote control operation.

1. Disconnect the receiver from the Remote Controller application, and then close the Remote Controller 

application.

2. Disconnect the receiver from the Remote Utility application, and then close the Remote Utility application.

3. Turn OFF the receiver and the PC.
 L If you check “Software closing turns OFF the Receiver.,” when you close the Remote Controller, the receiver’s 

power is also turned OFF.
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CONFIGURING THE SYSTEM THROUGH THE INTERNET3

Examples of the remote control system through the Internet

This section explains the minimum required settings to configure a remote control system through the 
Internet, using the following illustration as an example.

 • Only users whose ID and password are registered to the receiver can connect it. BE CAREFUL in managing IDs 

and passwords.

 • You can also refer to each application’s help file for assistance with the functions and settings. While the 
application is open, push the [F1] key on the PC’s keyboard to open the help file.

The user ID, password, and other settings in this 

illustration are only examples. Configure the system 
using your own settings.

For your convenience:

If you use an RC-28 remote encoder at the PC, 

you can use the RS-R8600 and feel like you are 

operating the actual receiver’s main dial.

RC-28 

(Optional)

PC Name:

User ID:

Password:

User PC

USER1

USER0001

IC-R8600abc

96h

Auto

Network Radio Name:

CI-V address:

Baud rate:

Connect to 

the LAN port

Receiver

InternetInternet

RouterRouter



3-2

3 CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service

If you configure the remote control system through the Internet, PCs can connect to the receiver using its public IP 
address or domain name.

 DTo let PCs connect to the receiver using its public IP address
A public IP address is an address that is accessible over the global Internet. Check the router’s manual about how 

to configure your router to set the public IP address.

NOTE:

If you have a dynamic public IP address, we recommend that you use the Dynamic DNS service to enable the 

PCs to connect to the receiver. (p. 3-3)

 L If the PC connected to the receiver is not using the Dynamic DNS service, you need to change setting of PC’s 

Remote Utility to connect to the receiver each time its public IP address changes.

Receiver

Router Router

IP address

WAN: ✽✽✽.✽✽✽.✽✽✽.✽✽✽

LAN: 192.168.0.1

Request “✽✽✽.✽✽✽.✽✽✽.✽✽✽”

(Public IP address)

PC

InternetInternet
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3 CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service (Continued)

 DTo let PCs connect to the receiver using its domain name
If you set up an account for a Dynamic DNS server, the DNS server resolves the domain name into your dynamic 

IP address. Using the domain name, PCs can connect to the receiver through the Internet, even if the receiver’s 

public IP address is changed.

 LCheck the router’s manual about how to configure your router to use the Dynamic DNS services.

IP address: 192.168.0.10

Dynamic DNS

server

Update with your dynamic

IP address

Receiver

InternetInternet

Router Router

IP address

WAN: ✽✽✽.✽✽✽.✽✽✽.✽✽✽

LAN: 192.168.0.1

Domain name

icom-rsr8600.com

PC

Request “icom-rsr8600.com”

(Domain name)
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3 CONFIGURING THE SYSTEM THROUGH THE INTERNET

To enable remote control through the Internet

If you configure the remote control system through the Internet, you need to configure your router to enable 
connections from the Internet.

To enable connections, forward the port used with the Remote Utility.

1 Set the static local IP address to the receiver or PC.

You need to set a static local IP address to the receiver or PC.

 LUsable IP addresses differ, depending on your router. Check the router’s manual for details.

 LDo not set the same IP address to two or more devices that are connected to the same router.

 LCheck your PC’s manual about the setting details.

2 Forward the port.

 • Forward port numbers that are used for the RS-R8600. (Example: 50001 to 50003)

 • “UDP” should be used as the port protocol.

 •  Set a static local IP address in Procedure 1 as a destination port.

 LCheck the router’s manual about how to forward ports.

 LDepending on the router settings, you must configure the IP filter settings. Check the router’s manual how 
to configure the settings.

Port numbers

50001 to 50003

IP Address:

192.168.0.100

Default Gateway:

192.168.0.1

DNS Server Address:

192.168.0.1

Default Gateway:

192.168.0.1

Port numbers

50001 to 50003

IP Address:

192.168.0.10

Receiver

Router

INTERNETINTERNET

Router

PC

Receiver setting

Items Contents

DHCP ON (Default)  OFF

IP Address An IP address that is not assigned to any other device.

Example: 192.168.0.10 (Default)

Default Gateway An IP address of the LAN side on the router

Example: 192.168.0.1

Control Port (UDP) 50001 (Default)

Serial Port (UDP) 50002 (Default)

Audio Port (UDP) 50003 (Default)
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3 CONFIGURING THE SYSTEM THROUGH THE INTERNET

Step 1. Settings on the receiver

This section describes how to setup the receiver.

To prevent unauthorized access:

Set a long and strong password so that no one can possibly guess it.

Mix upper and lower case letters, numbers or characters.

NOTE:

When you change a setting that shows “(Valid after Restart),” you must restart the receiver after setting, so it will 
take effect.

 • After restarting, keep the receiver’s power ON, or remain in the remote standby mode.

Network setting

Items Contents

Network Control OFF (Default)  ON

Internet Access Line Your internet access line type

Example: FTTH (Default)

Receiver registration

Items Contents

Network Radio Name A Network Radio Name

 • Up to 16 characters

Example: IC-R8600abc

User registration

Items Contents

Network User1/2

ID

A User ID

 • Up to 16 characters

Example: USER1

Network User1/2

Password

A Password

 • 8 to 16 characters

 • At least two different characters must be used.

Example: USER0001

Network User1/2

Administrator

NO (Default)  YES

 • When the user is set as an administrator.

Before setting a PC:

Confirm the items described below, and keep the receiver’s power ON, or remain in the remote standby mode.
 • Receiver’s public IP address or domain name

 • Network User ID and Password
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3 CONFIGURING THE SYSTEM THROUGH THE INTERNET

Step 2. Settings on the PC’s Remote Utility application

This section describes how to setup the PC.

 LBefore configuring the settings, connect a speaker to the PC.

1 Open the Remote Utility.

1. Open “Icom Remote Utility.”

2. “Set your own PC information” is displayed, 

then click <OK>.
 L When you first open the Remote Utility, this 
screen is displayed.

2
Configure the settings.

 L When you first open the Remote Utility, this screen 
is displayed.

1. Enter a name for your PC of up to 16 

characters. (Example: User PC)
 L DO NOT use the same name for more than one 

PC on your network.

2. Confirm the port numbers of the Control, 
Serial and Audio ports.

 L You should use the default port numbers for 

these ports.

3. Select the network connection type.

4. Select your internet access line type.

5. Select the software display language.
 L The selected language will be used as the Help 

file language.
6. Click <Register> to save the settings.

7. Click <OK>, and then restart the Remote 

Utility.

3

7Click

Click the Setup that you want to do.
 L If no Servers and no radios are registered, this 

screen is displayed.

Click Setup for a Remote PC (A radio with the 

Server function).

Click

4
Start the Setup Wizard.

Click <Next>>.

Click

Click

1 Enter

2 Confirm

3 Select

4 Select

6 Click

5 Select
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Step 2. Settings on the PC’s Remote Utility application (Continued)

5
Enter the Server Information.

1. Enter the receiver’s domain name or public 

IP Address.

2. Confirm the Control Port number.
 L You should use the default port number for this 

port.

3. Click <Next>>.

1Enter

3Click

6

1Enter

3Click

2Enter

NOTE:

If you cannot connect to the Server, an error dialog 

is displayed.

Click <<Back>, and confirm the settings.

(Example: USER0001)

Enter the User ID and Password.

1. Enter the User ID and Password that are 

registered to the receiver.

2. Click <Next>>.
 • After clicking <Next>>, connects to the Server.

7
Adding the Server has been completed.

1. Enter the Server Description.
 L The Server Address or Network Name is 

entered by default.

2. Click <Finish>. 1Enter

2Click

2Confirm
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Step 2. Settings on the PC’s Remote Utility application (Continued)

8
Configure the settings to connect to the 
receiver.

1. Select the receiver.

2. Click <Settings>.

3. Click <Recommended>.
 • The Select Network screen appears.

4. Select Internet.

5. Click <Next>.
 • The recommended values for your network are 

displayed. 

6. Click <Yes> to automatically set the 

displayed values in each field of the Network 
Setting, then close the Select Network 

screen.

7. Select a virtual COM port number.
 • The selected COM port number is used for CI-V 
operation with the receiver.

 L When you connect to the receiver with the 
control software, you have to set the COM port 

number.

8. Select an audio device that your speaker is 

connected, to output the received audio from 

the network.

9. Click <OK>.

1Click

2Click

3Click

4Select

6Click

5Click

7Select

8Select

9Click
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Step 2. Settings on the PC’s Remote Utility application (Continued)

9
Connect the receiver.

1. Click <Connect>.

2. Click <OK>.
 • “<<Connected>>” is displayed under the radio 

name when the connection has succeeded.

 L If the connection fails, and an error screen 

is displayed, solve the problem using the “6. 

TROUBLESHOOTING” section. (p. 6-2)

1Click

2Click
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Step 3. Remote control operation

This section describes how to connect and remotely control a receiver from a Remote PC using the Remote 

Controller.

 • The description in this section is based on the assumption that the connection to the receiver using the Remote 

Utility has succeeded. (“<<Connected>>” is displayed under the radio name.)

1 Connect setting using the Remote Controller application

1. Open “RS-R8600 Remote Control.”

2. Click <  > in the toolbar, or click “Connect Setting...” in the Option menu.
 • The Connect Setting screen is displayed.

3. Select a receiver to access using the Remote Utility application, in Remote Utility. 

(Example: IC-R8600abc)
 • The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the 

virtual COM Port number, receiver’s CI-V address and baud rate.
 L If the desired receiver is not displayed in Remote Utility, click <Search> to load the receiver’s information from the 

Remote Utility application.

4. Check “Software closing turns OFF the Receiver.” to turn OFF the receiver when the Remote 

Controller application is closed by clicking <  > or “Exit” on the File menu.
 • When the PC shuts down while the Remote Controller application is still running, the receiver’s power may not be 
turned OFF.

5. Click <OK> to save the settings and close the screen.

3Select

5Click
4Click
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Step 3. Remote control operation (Continued)

2 Connecting to the receiver using the Remote Controller application

Click <  > in the toolbar, or click “Connect ON” in the File menu.
 • When the connection has succeeded, the receiver’s current data will be displayed on the main panel.

3 Remote control operation

See the RS-R8600 Remote Controller’s Help file for remote operation details, such as how to change the 
frequency, or turn ON each function.

To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the 
[F1] key on your PC’s keyboard.

NOTE: DO NOT allow the PC to go into the sleep or standby mode while using the RS-R8600. Otherwise, it might 

not work properly after the PC resumes normal activity.

When not using the receiver:

Follow the steps below to close and exit the remote control operation.

1. Disconnect the receiver from the Remote Controller application, and then close the Remote Controller 

application.

2. Disconnect the receiver from the Remote Utility application, and then close the Remote Utility application.

3. Turn OFF the receiver and the PC.
 L If you check “Software closing turns OFF the Receiver.,” when you close the Remote Controller, the receiver’s 

power is also turned OFF.
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Setting your PC’s environment

Configure your PC’s environment in the Remote Utility.
The settings will take effect after rebooting the Remote Utility.

 LWhen you first open the Remote Utility, the Settings screen is displayed. 
After configuring the settings, you can display other setting screens.

1. Click “Options.”
2. Click “Settings.”

 • The “Settings” screen is displayed.
3. Configure the settings.
4. Click <OK> to save the settings.

 • “ The changes will be effect after the application 
restarts.” is displayed.

5. Click <OK>. 
The settings will take effect after restarting the 
Remote Utility.

1Click

2Click

1	PC Name

 Enter a name for your PC of up to 16 characters.
 DO NOT use the same name for more than one PC on your network.

2	Port numbers

 Enter the port numbers of the Control, Serial, and Audio ports.
 You should use the default port numbers for these ports.

3	Network Connection

  Select the network connection type.

4	Internet Access Line

 Select your internet access line type.

5	Language

  Select the software display language. 
The selected language will be used as the Help file language.

NOTE:

If you configure the remote control system through the Internet, and change the port number of the Control, 
Serial or Audio port, you should reconfigure the port forwarding settings and the IP filter settings on your router. 
(p. 3-4)

5Click

1

2

3

4

5

3 Set

4 Click
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Server Registration

To connect to a receiver through the network, Remote PCs should first connect to a Server using the Remote 
Utility. Before connecting, enter the Server information.

NOTE:

When you add a server from the Setup Wizard screen, click Setup for a Remote PC (A radio with the Server 

function).
 LTo display the Setup Wizard screen, click Setup Wizard on the top menu.

1Click

2Click

 DTo add a Server
1. Click <Server List>.
2. Click <Add>.

 • Set the Server information according the displayed 
screen.
 L When connecting to a receiver through a LAN, see 
page 2-3 about the settings. When connecting to a 
receiver through the Internet, see page 3-6.
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Server Registration (Continued)

 DTo change a server’s properties
1. Click <Server List>.
2. Select a server.
3. Click <Properties>.
4. Change the settings, and then click <OK>.

 DTo delete a server
1. Click <Server List>.
2. Select a server.
3. Click <Remove>.

1Click

3Click

2Select

1Click

3Click

2Select
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Connecting to a Server

 DConnecting to a Server
1. Click <Server List>.
2. Select a server.
3. Click <Connect>.

 • “Connected” is displayed under the Server name 
when the connection has succeeded.
 L If the connection fails, and an error screen 
is displayed, solve the problem using the “6. 
TROUBLESHOOTING” section. (p. 6-1)

 DDisconnecting from a Server
1. Click the <Server List> tab.
2. Select the connected server.
3. Click <Disconnect>.

1Click

2Select

3Click

1Click

3Click

2Select
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Connection setting

When the connection to the Server has succeeded, the receivers are displayed on the Radio List screen.
Select a receiver from the list, then connect it to the network using the Remote Utility.
You have to configure the network audio quality and devices to connect.

 LTo control the receiver, connect to the receiver using the Control software.

NOTE: 

If the connection setting is finished, you can simply connect to the receiver by selecting it in the Radio List 
screen and then clicking <Connect>.

1. Click <Radio List>.
2. Select a receiver.
3. Click <Settings>.

 L Receivers that are “<<Connected>>” or “Offline,” the 
Connection Setting cannot be changed.

1Click

2Select

3Click
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Connecting to a receiver

If the connection setting is finished, you can simply connect to the receiver by selecting it in the Radio List screen 
and then clicking <Connect>.

 DConnecting to a receiver
1. Click <Radio List>.
2. Select a receiver.
3. Click <Connect>.
4. Click <OK>.

 • “<<Connected>>” is displayed under the radio name 
when the connection has succeeded.
 L If the connection fails, and an error screen 
is displayed, solve the problem using the “6. 
TROUBLESHOOTING” section. (p. 6-2)

 DDisconnecting a receiver
1. Click <Radio List>.
2. Select a receiver with “<<Connected>>” under its 

name.
3. Click <Disconnect>.

 • “Do you want to disconnect the radio?” is displayed.
4. Click <Yes> to disconnect the receiver. 

NOTE: 

 • Be sure to disconnect when not using the receiver. 
Otherwise, other users cannot connect to it.

 • The administrators can terminate a connection 
between another user and a receiver. If 
“<<Connected>>” disappears while connecting 
to a receiver, the administrator may terminate the 
connection.

1Click

2Select

3Click

4Click

1Click

2Select

3Click

4Click
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Adjusting audio using the Remote Utility

While connected to a receiver, you can adjust the received audio volume through the network using the Remote 
PC’s Remote Utility.
The description in this section is based on the assumption that the connection to the receiver has succeeded.
(“<<Connected>>” is displayed under the radio name.)

1. Click <Radio List>.
2. Select a receiver with “<<Connected>>” under its 

name.
3. Click <AF>.
4. Slide the adjustment bar on the Volume field up or 

down to adjust the received audio volume level.
 L Click <Mute> to mute the audio, and click once again 
to hear the audio.

5. Click <Close> to close the screen.

NOTE:

 • The AF adjustment bar on the Volume field 
moves together with the AF control of the Remote 
Controller. However, if you use another control 
software, the audio volume level on the network 
can only be adjusted with the Remote Utility.

 • You cannot adjust the received audio volume level 
of the receiver’s speaker, with the Remote Utility. 
Use the AF control on the receiver to adjust it.

4Adjust

5Click

1Click

2Select

3Click
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Recording function

While connected to a receiver, you can record the received audio and save it into the PC’s hard disk using the 
Remote PC’s Remote Utility.
The description in this section is based on the assumption that the connection to the receiver has succeeded.
(“<<Connected>>” is displayed under the radio name.)

1. Click <Radio List>.
2. Select a receiver with “<<Connected>>” under its 

name.
3. Click <AF>.
4. Click < > to start recording.

 L While recording, click < > to pause.
5. Click < > to stop recording.

NOTE:

 • When you click <Folder Open>, the folder in which 
the recording file is stored will be displayed.

 • If you want to change the recording folder, click  
< >, then select a folder in the Browse For 
Folder screen.

 • Adjust the sample rate frequency and codec 
to record the audio according to the recording 
purpose. When you record the audio received 
from the network, we recommend that you set the 
same sample rate frequency and codec that are 
programmed in the Connection Setting screen.

Record button

Stop button
Pause button

Open the folder
Recording file name
Elapsed time

Folder browse buttonRecording folder name

1Click

2Select

3Click
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Disconnecting another users

The administrators can terminate a connection between another user and a receiver.

1. Click <Radio List>.
2. Select a receiver with “Busy” under its name.

 L The operating user’s name (PC Name that the user 
set in the Settings screen), and its IP address are 
displayed under “Busy.”

3. Click <Disconnect>.
 • “The radio is in use by a remote PC. Do you want to 
disconnect?” is displayed.

4. Click <Yes> to terminate the connection.
 L When you terminate a connection, no dialog is 
displayed on the disconnected user’s Remote Utility.

1Click

2Select

3Click

4Click
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Connect to the Base station transceiver.

(p. 2-7, p. 3-10)

About the Remote mode

(p. 5-2)

Open the Connect Setting screen.

(p. 2-7, p. 3-10)

TIP: See the RS-R8600 Remote Controller’s Help file for remote operation details, such as how to change the 
frequency or how to turn ON each function. To display the Help file, click “Contents” in the Help menu on the 
Remote Controller application, or push the [F1] key on your PC’s keyboard.
The windows that are displayed by right-clicking on each button on the Remote Controller, see the Operating 
Guide at the end of this manual.
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About the Remote mode

When connected to the receiver, the Remote 

Controller automatically turns ON the Remote mode.
While the Remote mode is ON, the Remote Controller 
transmits CI-V commands not only to check the 
receiver’s current state, but also to remotely control it.
When you want the Remote Controller to only check 
the receiver’s current state, or when you want to 
inhibit the Remote Controller from transmitting control 
commands, while you manually operate the receiver, 
turn OFF the Remote mode.

To turn OFF the Remote mode

Click the right icon in the toolbar, or click 
“Remote OFF” in the File menu.

To turn ON the Remote mode

Click the right icon in the toolbar, or click 
“Remote ON” in the File menu.

Using the RC-28

If you connect an optional RC-28 remote encoder to 

the Remote PC, you can use the RS-R8600 and feel 
like you are operating the actual receiver’s main dial.

1. Connect the RC-28 to the PC that has RS-R8600 
installed.
 • DO NOT connect the RC-28 to the PC with other than 
the supplied USB cable or through any USB hub. The 
RC-28 may not work properly.
 L When you connect the RC-28 to the PC for the first 
time, wait until “Device driver software installed 
successfully.” is displayed.

2. Start up the RS-R8600 Remote Control software.
 • The [LINK] indicator on the RC-28 lights green.

3. Now you can control the assigned functions of the 
RS-R8600 using the RC-28.

NOTE:

If the [LINK] indicator does not light, check the 
following.
1. Click “USB Dial...” in the Option menu to open 

the USB Dial Setting screen.
2. If Select Device is set to “Not Use,” set it to the 

RC-28’s serial number. 

(Example: RC-28 02XXXXX)

PC

RC-28

USB cable (supplied)
to a [USB] port

1

2

[LINK] indicator
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The following descriptions are possible causes and solutions for the problem you are experiencing.

If you cannot solve the problem after trying these solutions, please contact your nearest Icom Dealer or Service 

Center.

Problem: Cannot access a Server from a remote PC with the Remote Utility

 LYou can configure the Server information in the Server Properties screen. 
(Server List screen ➔ <Properties>)

“Connection Failed” is displayed under the Server name

“Logon Failed” is displayed under the Server name

“Disable” is displayed under the Server name

Possible cause 1

An incorrect IP address, domain name, or network name is entered to request a 
connection to the Server.

 L If the Remote Utility cannot get the receiver’s IP address using the domain name or 
network name that you entered, “Cannot resolve the name” is displayed next to the 
name.

Solution

1. Check the receiver’s IP address, domain name, or network name. (pp. 2-2, 
3-2)

2. Enter the receiver’s correct IP address, domain name, or network name in Server 

Address or Network Name in the Server Properties screen. 

Possible cause 2

The control port number is different than that of the receiver.

Solution

1. Check the receiver’s control port number*. (pp. 2-2, 3-4)
2. Enter the correct port number into Control Port (UDP) in the Sever Properties 

screen. 

* The default number is “50001.”

Possible cause

The user ID or password is different than the one in the receiver.

Solution

1. Confirm the Remote PC information registered in the receiver. (pp. 2-2, 3-5)
2. Enter the correct user ID and password into User ID and Password in the Sever 

Properties screen.

Possible cause

The Server is set to “Disable,” to inhibit connecting to it.
Solution

Enable the Server by removing a check mark from Disable in the Sever Properties 
screen.

NOTE:

If you could not solve the problem after trying the above solutions, check the following.
 • Is the receiver turned ON?

 • Is Network Control set to “ON”? (pp. 2-2, 3-5)
 • Is the virtual driver installed in the PC? (See the RS-R8600 Preparations for details.)
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Problem: Cannot access a receiver with the Remote Utility

The description in this part is based on the assumption that the connection to the Server has succeeded.

 • “Connected” is displayed under the Server name when the connection is successful.

“Busy” is displayed under the radio name

“Connect Error” is displayed under the radio name

“COM/Audio Error” is displayed under the radio name

Possible cause

Another user is currently operating the receiver.

Solution

Wait for “Busy” to disappear.
 L If you are operating as an administrator, you can terminate a connection between 

another user and a receiver. (p. 4-9)

Possible cause

The serial port number (default: 50002) or the audio port number (default: 50003) is 
not connected.

Solution

Check the Firewall settings for the Remote PC.
When using the internet, also check the router’s port forwarding settings. (p. 3-4)

Possible cause 1

Other applications are using the COM port.

Solution

If other applications are running at the same time, close them.

Possible cause 2

Started the Remote Utility right after the PC has booted.
Solution

Wait for a while after the PC has booted, and then start the Remote Utility.

NOTE:

If you could not solve the problem after trying the above solutions, check the following.
 • Is the receiver turned ON or in the remote standby mode?
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Problem: Cannot access a receiver with the Remote Controller

 LTo access a receiver with the Remote Controller, configure the connection settings in the Connect Setting 
screen. Click <  > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.

The description in this part is based on the assumption that the connection to the receiver using the Remote Utility 

has succeeded.

 • “<<Connected>>” is displayed under the radio name when the connection is successful.
Possible cause 1

In CI-V of the Remote Controller’s Connect Setting screen, the CI-V settings are different than that in the 

Remote Utility.

Solution

In the Connect Setting screen, click <Search>, and then select the correct receiver in the Remote Utility 
menu.

 • The CI-V settings are automatically loaded from the Remote Utility.

Possible cause 2

Other applications are using the COM port.

Solution

If other applications are running at the same time, close them.

NOTE:

If you could not solve the problem after trying the above solutions, check the following.
 • Is the receiver turned ON or in the remote standby mode?
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Problem: Cannot properly control the receiver with the Remote Controller

Problem: The received audio cannot be heard

The description in this part is based on the assumption that the connection to the receiver has succeeded.

 • “<<Connected>>” is displayed under the radio name when the connection is successful.

Possible cause

The same CI-V address is being used by other control software.

Solution

Select an address other than “E0” in CI-V Address (RS-R8600) in the Remote Controller’s Connect 

Setting screen. However, this solution does not always solve the problem.

Possible cause 1

The speaker is not turned ON, or the volume level is too low.
Solution

Turn ON the speaker, or adjust the volume level.

Possible cause 2

An earphone or other device is connected to the computer in place of the speaker.
Solution

Disconnect the device.

Possible cause 3

The appropriate audio device is not selected in the Remote Utility.

Solution

Select the appropriate audio device in Speaker in the Connection Setting screen.

(Radio List screen ➔ <Settings>) (pp. 2-5, 3-8)
 L If you connect a new USB audio device to your PC, the audio device which is selected as a default 
device in your PC can be changed. If you select “Default Device” in Speaker, please keep that in 
mind.

Possible cause 4

The volume level of the audio device is set to too low on your PC.
Solution

Adjust the volume level of the audio device. (p. 1-4)
 LThe PC has the Volume Mixer function that can adjust each application’s audio level. Confirm that the 
Remote Utility or the control software is not muted, or set it to an appropriate volume level.

Possible cause 5

Audio output is disabled in the Remote Utility.

Solution

Insert a check mark in AF Transmission in the Connection Setting screen.

(Radio List screen ➔ <Settings>)

Possible cause 6

The volume level is too low, or the mute is turned ON in the Remote Utility.

Solution

Adjust the volume level in the Received Audio Adjustment screen.
(Radio List screen ➔ <AF>) (p. 4-7)

NOTE:

If you could not solve the problem after trying the solutions, check the following.
 • Are there any radios that have the same CI-V address in the system?
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Problem: The received audio is intermittent

Problem: The connect settings cannot be changed

Possible cause 1

The network data transfer is excessive.
Solution

Select a lower sampling rate value in Sample Rates, or a different codec in Codecs, in the Connect 

Settings screen. (Radio List screen ➔ <Settings>)
 LFirst, select the lowest value. If the received audio is not interrupted with the setting, try a higher 
value, and adjust to an appropriate value.

Possible cause 2

The capacity of the prebuffer is not enough.

Solution

Select a longer value in Prebuffer (ms) in the Connection Setting screen.

(Radio List screen ➔ <Settings>)
 LSelect as short a value as possible, because longer prebuffers can cause a delay, and make it difficult 
to adjust the audio level.

Possible cause 3

Your PC is overloaded.
Solution 1

Shutdown other applications, if running.

Solution 2

Reduce the number of receivers you are accessing with the Remote Utility.

Possible cause 1

The receiver is “Offline.”
Solution

Click <Connect> on the Server List screen to connect to the server.

Possible cause 2

“<<Connected>>” is displayed.
Solution

Click <Disconnect> on the Radio List screen to disconnect from the receiver.

NOTE:

 • If you are accessing the receiver through a network, removing a check mark from Retransmission 

in the Connection Setting screen can solve the problem. 

(Radio List screen ➔ <Settings>)
 • You can check the simplified packet round trip time, and the average packet loss in the Remote 
Utility’s Server List screen.

Packet round trip time Average packet loss



6-6

6 TROUBLESHOOTING

Problem: The connect settings cannot be changed using the Remote Controller

Possible cause

The Remote Controller is connected to the receiver.

Solution

Click <  > to disconnect it from the receiver.
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Operating Guide
The following windows are displayed by right-clicking on each button on the Remote Controller.

 LThe windows that are displayed by left-clicking, the buttons are marked in white (Example: Memory Channel Editor).

Displayed windows differ, according to the 

selected receive mode.

FM

NXDN

dPMR

DCR

FM D-STAR

P25 NXDN, DCR

dPMR

Displayed windows 

differ, according to the 

selected receive mode.

dPMR
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